
 
 

 
 
 
 

 
PRO Access Management Software 

User Manual 
 
 
 
 
 
 
 
 
 

 

                                                                                                  



                                                                                                              PRO Software User Manual Ver 1.00E 
   

     www.xprsec.com

Table of Contents 
 
1 INTRODUCTION ...................................................................................................................... 4 

1.1 KEY FEATURES....................................................................................................................................4 
1.2 HOW TO USE THIS MANUAL ................................................................................................................4 

2 TECHNICAL DETAILS............................................................................................................. 4 

3 INSTALLATION ....................................................................................................................... 5 
3.1 MINIMUM SYSTEM REQUIREMENTS.....................................................................................................5 
3.2 HARDWARE INSTALLATION CHECK......................................................................................................5 
3.3 INSTALL PRO SOFTWARE ....................................................................................................................5 

4 PRO IN ONLINE/OFFLINE MODE........................................................................................... 8 

4.1 PRO IN ONLINE MODE.........................................................................................................................8 

5 FILE MENU .............................................................................................................................. 9 
5.1 CONFIGURATION..................................................................................................................................9 
5.2 SEQUENTIAL TAGS ............................................................................................................................11 
5.3 GLOBAL SYSTEM PARAMETERS..............................................................................................12 

5.3.1 Communication Settings...........................................................................................................13 
5.3.2 Backup Settings ........................................................................................................................14 
5.3.3 Controller Settings....................................................................................................................15 
5.3.4 Synchronization Settings ..........................................................................................................16 

5.4 COMMUNICATION .......................................................................................................................17 
5.5 SEARCH ..........................................................................................................................................20 
5.6 EXIT .................................................................................................................................................20 

6 NETWORK ............................................................................................................................. 20 
6.1 FREE ACCESS (DOOR)........................................................................................................................21 
6.2 O2LA................................................................................................................................................21 

7 READER GROUP .................................................................................................................. 24 

8 TIME ZONES.......................................................................................................................... 26 
8.1 PRIORITY ALARMS ............................................................................................................................28 
8.2 FREE ACCESS (TIME) .........................................................................................................................29 

9 HOLIDAYS ............................................................................................................................. 29 

10 USER GROUPS.................................................................................................................. 31 

11 USERS................................................................................................................................ 34 

12 EXPORT ............................................................................................................................. 38 

13 IMPORT .............................................................................................................................. 39 

14 OPERATORS SETTING..................................................................................................... 39 

15 REPORTS........................................................................................................................... 42 
15.1 REPORT WIZARD ...............................................................................................................................42 
15.2 EVENTS REPORT ................................................................................................................................46 

                                2 

15.3 GRAPHICAL REPORT..........................................................................................................................48 



                                                                                                              PRO Software User Manual Ver 1.00E 
   

     www.xprsec.com

15.4 SAVED REPORTS................................................................................................................................50 
15.5 TAG DETAILS REPORT .......................................................................................................................50 
15.6 ATTENDANCE REPORT.......................................................................................................................51 

16 BACKUP............................................................................................................................. 53 
16.1 MANUAL BACKUP .............................................................................................................................53 
16.2 RESTORE DATABASE .........................................................................................................................54 
16.3 CLEAR EVENT DATABASE .................................................................................................................54 

17 DIAGNOSTICS ................................................................................................................... 55 

18 DISABLE ALARM .............................................................................................................. 56 

19 SETTING RECORDS.......................................................................................................... 56 
19.1 READER GROUPS SETTINGS REPORT .................................................................................................57 
19.2 TIME ZONES SETTINGS REPORT.........................................................................................................57 
19.3 HOLIDAYS REPORT............................................................................................................................58 
19.4 USER GROUPS SETTINGS REPORT......................................................................................................59 
19.5 USER DETAILS REPORT .....................................................................................................................59 
19.6 USER GROUP WITH (APB) SETTINGS REPORT ...................................................................................60 
19.7 DOOR CONTROLLERS WITH (APB) SETTINGS REPORT ......................................................................60 

20 HELP .................................................................................................................................. 61 
20.1 ONLINE HELP ....................................................................................................................................61 
20.2 ABOUT...............................................................................................................................................61 
20.3 REGISTRATION...................................................................................................................................61 

21 Changing Languages: ...................................................................................................... 62 

22 TROUBLE SHOOTING....................................................................................................... 63 

23 GLOSSARY........................................................................................................................ 64 

24 FEEDBACK ........................................................................................................................ 65 

25 Disclaimer.......................................................................................................................... 66 

                                3 

26 COPYRIGHT....................................................................................................................... 66 



                                                                                                              PRO Software User Manual Ver 1.00E 
   

     www.xprsec.com

 

1 INTRODUCTION 
 
The Microsoft® WindowsTM based On/Off Line Access control PRO software has three special 
features - easy & user-friendly programming, real-time monitoring and reporting. Using normal 
Windows techniques (dialogue boxes, drop-down menus, etc.) programming has been made so 
user-friendly that most novices can program the O2LA system in a few minutes. 
 

 Key Features 1.1 

1.2 

 
• Online Monitoring / Controlling / Programming 
• Generate customized reports. 
• Menu-driven operation (with dialogue boxes and drop downs). 
• Receives / transmits data/events from Extension Units. 
• Extension Unit diagnostics status 
• Image and other details of user can be displayed on computer screen. 
• Help menu for online support. 

 
How to Use this Manual 

 
The manual is presented in a step-by-step, rational sequence to facilitate comprehensive under 
standing of the software and its use. With its logical division into sections, subsections, schematics 
and labeling it could be used as a Quick reference guide. It is advisable for beginners to read this 
manual before starting to program. 

Notes in the manual are highlighted with this symbol    

Cautionary messages are highlighted with this symbol  . 
 
The manual also presents useful Tips. 
 
2 TECHNICAL DETAILS 

 
PRO Software will function using the Operating systems listed below. 
• Windows 98 Second Edition. 
• Windows 2000. 
• Windows XP Professional 
• Windows XP Home Edition. 
 
Communication using a RS 232 cable is possible up to a 15-meter distance. Longer distances 
may be possible, depending upon the computer and type of cable. 
For Online Communication between O2LA and PRO the following Modems are recommended. 
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Modems 
U.S Robotics Message Modem (V.92) 
D-Link DFM 562 E++ (V 92) 
D-Link DFM 560 ES (V 90) 
ZyXEL Omni 56k (V 90) 
Lancer 56k 

 

 
Ideally the same ITU Version V92 or V90 compatible Modems should be used on 
both sides or it could create problems. 

 
3 INSTALLATION 
 
This Chapter specifies requirements for efficient operation of the O2LA PRO Software. 
 
3.1 

3.2 

1. 
2. 

3. 

4. 

Minimum System Requirements 
 

• Windows 98 SE/2000 / XP Professional/Home edition. 
• 64 MB RAM, Preferred 128 & above. 
• 60 MB hard disk free space. 
• RS 232 SERIAL (COM) Port or USB Port with USB – RS 232 Converter. 

 
Hardware Installation check    

 
Check all wiring to the O2LA and Extension Units. 
Check the Extension Unit addresses. Every RS-485 network device must have a unique 
address (these are set using the dipswitches). 
Check that the O2LA controller is connected to a PC, via a RJ12-RS232 cable. If the 
computer does not have an RS232 port, connect the controller using a USB-RS232. 
Power up the O2LA controller. 

 

 
In case of any difficulty, please refer to the O2LA manual for detailed information 
on the O2LA system, or consult your installer. 

 
3.3 Install PRO software 
 
1. Insert the PRO CD into the CD drive of the computer and follow the on-screen installation 

instructions. If installation does not start automatically, run the “setup.exe” file. 
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2. When installation is complete, click Programs O2LAPRO  O2LAPRO from the Start Menu 
or click on the O2LAPRO icon on the desktop.        
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The PRO Software will dynamically detect for available COM Ports, and 
automatically connect to the COM Port to which O2LA is connected.  

 
If no COM Port is available in the computer or if other devices are using the available ports, the 
following message is displayed: 

 
 

Click Yes to continue working in Offline mode. 
 
3. Log in using Name and Password: 

 
 

 

 
 

 
 
 

 
The factory set default Name and Password are “Administrator” and “admin” which 
are to be used until they are changed. 
 
 
Name and Password are case sensitive. 
 
Use the Operator Settings menu (Refer to page 39) to change the administrator 
password immediately after installation, and periodically thereafter. It is advisable to 
keep the administrator Name and Password in a secure place. 

 
 

 
4. Similarly, other Operators can login with his/her login name and password, which have been 

assigned by the Administrator in the Operator settings option (Refer to page 39). 
 
5. After successfully logging in, PRO’s main screen is displayed. 
 

                                6 



                                                                                                              PRO Software User Manual Ver 1.00E 
   

     www.xprsec.com

 
 

  

 

Once the PRO Software is installed, it can be used in Offline mode. Before the 
PRO Software can communicate with the O2LA controller, the PRO needs to be 
registered (refer to page 61). 

 
6. When PRO is registered, the following screen is displayed for the synchronization of data 

between PC and the O2LA Master controller. 

 
 

 

Synchronization is the data transfer between O2LA and the PRO software. In the 
process of synchronization, data is first imported from O2LA to PRO and then 
exported back from PRO to O2LA. The purpose of synchronization is to have 
identical databases in PRO and O2LA. 
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7. Click Yes to synchronize the data and when completed the following message is displayed. 
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4 PRO IN ONLINE/OFFLINE MODE 
 
PRO is in Online mode when there is communication between PRO and O2LA. 
 
PRO is in Offline mode if there is no communication between PRO and O2LA. However, each of 
them can function independently. 
 
On the PRO main screen click on the Go Online button at the top right of the screen to switch to 
Online operation mode. The circular green icon is displayed. 
 

 
 

 
If the Registration details entered for PRO are incorrect or not entered, the 
message below is displayed and you cannot work in Online mode. 

 
To register PRO in Online mode refer to page 61. If the PRO does not recognize the O2LA 
controller, the following message will appear. 

 
 
Click Go Offline on the PRO main screen to switch to Offline mode operation. The circular red 
icon is displayed. 
 

 
 
4.1 PRO in Online mode 
 
When the PRO software is in Online mode, and an event occurs, an online monitoring screen is 
displayed listing the events as they occur. 
 
Online Monitoring 
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On the PRO main screen click the Display Events button. The Online Monitoring screen, with a list 
of events, is displayed as shown below. 



                                                                                                              PRO Software User Manual Ver 1.00E 
   

     www.xprsec.com

 
 

PRO has a unique feature, in that a photograph of each user that is granted or denied access can 
be viewed on the Online monitoring screen. To enable this feature, a scanned photo image should 
be inserted when registering the User.  
 
 

 

For best results, the image size should be as given below:  
Photo size: 23mm (width) x 28 mm (Height) 
Pixels: 69 x 85 
Resolution: 30 
Image type: JPEG 
Scanned images can be edited using an Image editing tool like Photo Shop or 
Corel Draw to achieve the above specifications. 

 
5 FILE MENU 
The File menu has six drop down sub menus. 
 

• Configuration 
• Sequential tags 
• Global System Parameters 
• Communication 
• Search 
• Exit 

 
5.1 Configuration  
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With this option the Company name, address and logo can be displayed on the PRO main screen 
and Report layout can be customized.  
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Click Configuration on the File menu and the following screen is displayed: 

 
 

1. To enter the Company logo, click the Add button and the following window is displayed. 

 
 
 

2. Navigate and select the image from the folder and click the Open button. 
3. To remove an existing Company logo click the Remove button. 
4. Enter the Company name and other details to be displayed in the reports. 

 
Even after the data is entered, it will appear on the report only if the relevant 
checkbox on the Configuration screen is ticked. 
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5. Click the Save button to save the Configuration details entered. 
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5.2 Sequential Tags 
 
From this menu, Tag numbers can be generated sequentially. It saves time and effort when 
entering hundreds of numbers. The numbers generated here can be assigned to Users in the User 
details screen (Refer to page 34).  
Click Sequential tags in the File menu and the following screen is displayed. 

 
 

 A list of Sequential tags can be generated at one time, and assigned to Users 
as and when required. Assigning tag numbers to Users need not be 
sequential. 

 
To Generate a set of Tags 

1. Click the New button. 
2. Enter the total number of tags to be entered. 
3. Enter the number of the first tag in the sequence to be generated. 

 
Enter the last five digits of the starting number of the tags to be generated 

4. Click the Save button and the set of tags are generated and listed in a table. 

 
Tag numbers list 

 
5. If the tag numbers exist already an error message “Created 0 Tags ” is displayed. 
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 A maximum of 1,000 tags can be generated. 

6. Click the Hide all to hide the Tag number list. 
7. Click the View all to view the Tag number list. 
 

To Delete individual Tag numbers 
1. In the Tag numbers list select the Tag number(s) to be deleted. 

 
 

2. To select all the Tag numbers, click on the  Select all checkbox. 
3. Click the Delete button and the following message is displayed. 

 
4. Click Yes to Delete. 

 

 
Tag numbers with an active status (assigned to a User) cannot be deleted. 

 
 If there are sequential numbers with some gaps, it might be easier to enter the 

full sequence and delete numbers where appropriate. 

 
5.3 GLOBAL SYSTEM PARAMETERS 
 
A number of options for configuring the system to suit individual preferences are given on this 
screen. 
There are four tabs under User Global settings: 

                                12 
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5.3.1 Communication Settings 
 
Communication Mode, Communication Port, Export Reminder and Online Printing options can be 
selected. 
 

1. Select the Communication Mode (RS232 or Modem) for communication between O2LA and 
the PC. 

2. Select the Communication Port. 

 
PRO automatically recognizes all free Serial Ports present in the system and 
displays them for selection. 

3. If you select Modem for communication, it is also necessary to enter the telephone number. 
4. Select the type of dialing i.e. Pulse or Tone. 

 
Enter the Telephone number based on the communication type (Refer to page 
17). 
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5. Select the type of Export Reminder. 
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Based on the type of  Export Reminder selected, the User is prompted to 
export data changes (Add, Modify or Delete in User groups, Reader groups, 
Time zones, etc.) from PRO to the O2LA Controller. 
The Export Reminder is there only as a prompt. Export can always be done 
using the “Export” option and is automatically done during synchronization. 

 
a. Remind Always: PRO immediately prompts to export data as soon as any change is 

made to the data. 
b. Don’t Remind today: PRO does NOT prompt to export data for the whole of that 

particular day.  
c. Don’t Remind till next Start up: PRO does not prompt to export any changes until 

the next start-up of PRO. 
d. Never Remind: The PRO never prompts to export data. 
 

6. For Online Printing, check Enable Online Printout and select the set of events to be 
printed at each interval. 

 

With this option, the frequency with which online printing takes place is 
selected. Printing can be after 25, 50, ….. 500 (max) events have occurred. 
For Online printing a serial printer has to be connected to the computer. 

 
7. Click Save to save the user-defined Communication settings. 
8. Click the Sample button to view the Default Communication settings. 
 

5.3.2 Backup Settings 
This option refers to how frequently certain precautionary steps need to be automatically done e.g. 
Database backup, Events download, etc. 

                                14 
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1. Click on the Backup tab. 
2. For Database Backup check the enable automatic backup. 
3. Click the Add button and select the path for the database backup file. 
4. Select the frequency of the backup by clicking on the appropriate button. 

• Day: Database backup is taken automatically when date changes. 
• Weekly: Database backup is taken automatically after every seven days. 
• Monthly: Database backup is taken automatically on the change of each month. 

5. For events download from O2LA (Importing), check enable automatic download of events 
and select the interval. 

6. Click the Save button to save the Backup settings. 
7. Click the Sample button to view the Default Backup settings. 

 
5.3.3 Controller Settings 
 
This option is exclusively for the selection of Extension units used with the O2LA Master unit. Only 
the EW units selected here are displayed in Network option, where settings can be done for 
O2LA and Extension units. 
 
 With this feature, it allows the pre setup of all extension units before 

incorporating them in the network installation at a later date.  

 

 
. 

1. Select the EW units (corresponding to the peripheral numbers assigned to them using 
dipswitches) that are to be incorporated into the network.  

2. Click the Save button to save the Controller settings. 
3. Click the Sample button to view the Default Controller settings. 

                                15 
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5.3.4 Synchronization Settings 
 
With this screen, as shown below, Date and Time synchronization from the O2LA controller to 
PC (or vice versa) is possible. 
 

 
 

 In general, the date/time settings in O2LA and the system settings will not be 
the same. They can be matched using this screen. 

 
This screen, with the Startup language selection, allows the choice of language at the PRO 
startup. 

1. Click the Enable Date and Time Synchronization checkbox.  
2. Click the O2LA to PC radio button ( ), for date and time transfer from O2LA to PC. In this 

option, the Date and Time displayed in O2LA is imported to PRO and displayed on the PRO 
main screen. 

 
Date and Time synchronization from O2LA to PC does not change the system 
date. 

3. Select the PC to O2LA radio button ( ), for date and time transfer from PC to O2LA. 
In this case the Date and Time displayed on the PRO main screen is exported to O2LA. 
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4. Select the Synchronize Interval type as Day, Weekly, Monthly or Every Startup. 
5. Based on the Synchronize Interval type selected, select the interval value. 
6. Select the Language in which the login screen at startup is to be displayed. 
 

 
The language options available in this particular version of the PRO are shown 
in the drop down menu. 

 
As an example, if the startup language selected is French, the next login start up screen 
will display the following:  

 
 

7. Click the Save button to save the synchronization settings.  
8. Click the Sample button to view the Default Synchronized settings. 
 

5.4 COMMUNICATION 
 
This option allows setting up the mode of communication and its parameters. Communication 
between O2LA and PC can be in one of three different ways. 
 
Type1: 
 
 
 
Type2: 
 
 
 
 
 
 
 
 
Type3: 
 
 
 
 
Under Type 3 communication there can arise three different situations, as explained below: 
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Telephone line RS 232 Cable

Telephone lineRS 232 Cable
PC Modem PSTN

ModemO2LA

RS 232 Cable 

RS 232 
CablePC Modem DPBX PSTN

DPBXModemO2LA

PC O2LA
RS 232 Cable 
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Situation 1: The PC is dialed through a DPBX central telephone line and O2LA has a standard 
PSTN line.  
 
Situation 2: The PC is dialed through a standard PSTN line and O2LA has a DPBX central 
telephone line having, for example, the extension number 215 
 
Situation 3: The PC and O2LA have both a DPBX central telephone line.  
 
PSTN -> Public Switched Telephone Network. 
DPBX -> Digital Private Branch Exchange. 
 
Click the Communication option in the File menu, and the following screen is displayed: 

 
 

1. Select the Mode of communication as Modem. 

 
2. Select the Communication Port. 

 
PRO automatically recognizes all the Communication Ports present in the 
computer and displays them for selection. 

3. Enter the telephone number. 
• If the mode of communication is of Type 2, enter the direct telephone number as shown 

in the figure below. 
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• If the mode of communication is of Type 3: Situation 1, enter the telephone number as 

shown in the figure below: 

 
• If the mode of communication is of Type 3: Situation 2, enter the telephone number as 

shown in the figure below (not forgetting the extension number attributed to the O2LA 
central telephone line). 

 
• If the mode of communication is of Type 3: Situation 3 enter the telephone number as 

shown in the figure below (not forgetting the extension number attributed to the O2LA 
central telephone line). 

 
 Each Comma induces a time delay of 1 second.  

Enter the number of Comma’s based on the time delay required. 
 

4. Click the Dial button for starting communications.  

 
The number is dialed according to the configured mode “Tone” or “Pulse”. 
The configuration modes are set in the Global system parameters  -> 
Communication tab (Refer to page 13). 

5. When communication with the O2LA is established, the following message screen will appear. 
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6. Click the Disconnect button to disconnect the Modem connection.   
 

 SEARCH 5.5 
 
The Search option allows you to quickly search for details about any   user or group of users with 
common parameters.. The output information to be listed is also selectable.  

 
 

1. In the Look in selection box, click the button ( ) and select the search parameter. 
2. Within the parameter selected, enter the text to be searched. 
3. For the search parameter, select the details to be displayed in the Search Results table. 
4. Click the Search button to start the search and display the result. 

 
 EXIT 5.6 

 
Click the Exit button in the File menu to close the application. 
 
6 NETWORK 
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The Network menu enables programming of the Controller (O2LA) and Extension Units (EW). It 
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consists of two default sub-options i.e.  Free Access and O2LA. This menu also lists the EW units 
selected through the Controllers tab -> Global Parameters screen (Refer to Page 15). 
 
6.1 Free Access (Door)  
 
Free Access provides access without need for code or card. It can be programmed only for 1 door 
on the whole system e.g. car park . 
In Free Access, one access point is configured and the time schedule for Free Access is defined in 
Time Zone03 -> Free Access (Time) option (refer section 8.2 ). 
 

 
Free Access is linked to the default Time zone 03(Free Access time). 

 
 
  

 
Only one door can be configured for Free Access in the O2LA / EW network. 
Free access should never be used for doors giving access to secure areas or to 
doors configured with Mantrap. 

1. Double click the Free Access (Door) icon. 
Or 

2. Right click  on the Free Access (Door) icon + Click Open. 

 
3. Click the Modify button. 
4. Select the Door Controller (the Controllers selected in Controllers tab ->Global system 

parameters screen are displayed for selection).  
5. Select the Door.  
6. Click the Save button to set the Free Access (Door) settings. 

 
6.2 O2LA  
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This option allows O2LA settings to be programmed. O2LA has three sub options i.e. Door1, 
Door2 and Auxiliary Outputs. 
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Door 1 settings 
 

1. Expand the O2LA menu (click on “+”). 
2. Double click the Door 1 sub-option or right click the Door 1 sub-option and click View. 

 
 

3. Click the Modify button. 
4. Enter the Door 1 description (a convenient door identification name). 

 

 
By default the Controller number for O2LA is 00 and cannot be changed.  
By default the Controller description is given as O2LA, which can be changed. 

5. Select either Latch or Pulse mode for the door. If Pulse then set the door timing (1 to 240 
seconds). 

6. Tick the Enable Anti-Pass back, if required. When enabled, Reader 2 automatically 
becomes the OUT reader for Door1. 
Or 
Tick the Enable Mantrap, if required. 

7. Click the Update button to save the settings. 
 
Door 2 Settings 
 
1. Expand the O2LA menu (click on “+”). 
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2. Double click the Door 2 sub-option or right click on the Door 2 sub-option and click View.  
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3. Click the Modify button. 
4. Enter the Door 2 description (a convenient door identification name). 
5. Select either Latch or Pulse mode for the door. If Pulse then set the door timing (1 to 240 
seconds). 
 

 
If Door1 is Anti-Pass back enabled, then the Latch or Pulse mode selected 
here is for the Out reader of Door 1. 

6. Click the Update button to save the settings. 
 
Auxiliary Output settings 
 
1. Expand the O2LA menu (click on “+”). 
2. Double click the Aux1/Aux2 sub option or right click on the Aux1/Aux2 sub option and click 

View. 
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3. Click the Modify button. 
4. Enter the 3rd Output description ( i.e. a preferred name for the 3rd Output). 
5. Select either Latch or Pulse mode for the 3rd Output, if pulse then set the timing (1 to 240 

seconds). 
6. Enter the 4th Output description ( i.e. the preferred name of the 4th Output). 
7. Select either Latch or Pulse mode for the 4th Output, if Pulse then set the timing (1 to 240 

seconds). 
8. Click  the Update button to save the settings. 
 

 
Settings for Extension Units in the Network menu are done in a similar 
manner to that of the O2LA controller, explained above. 

   
7 READER GROUP 
 
The Reader Group is a convenient grouping of the O2LA controller and/or Extension Units (00 to 
31) with permissions for associated readers linked to doors.  
Click (+) Reader Group and the folder expands, displaying 2 default Reader Groups i.e. “No 
Access” and “Full Access”, which cannot be altered. 

1. No Access (00): Access denied for all doors in the system. 
2. Full Access (01): Permanent access to all doors in the system. 
 

Double click on either of the default Reader groups and the following screen is displayed. 
 

 
 

    Extension unit doors for selection are given based on the EW units selected in the Global 
system parameters -> Controllers screen (Refer to page 15).  
 
Create a Reader Group 
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1. Right click the “Reader Group” on the tree structure and then click  “new”. 
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Or 
2. Click (+) Reader Group and double click on either of the default Groups “No Access” or 

“Full Access” icons 
3. In the Reader Group screen click the New button. 
4. Enter a description for the Reader Group. 
5. Tick against Door1 and/or Door2 of one or more Extension Units to form a Group. 

 

 
If the Controller or Extension Units selected are Anti-Pass back enabled, the 
D2(R2) will be the Out Reader for the Door 1 selected. 

 
6. Click the Save button, the Reader Group created is saved and added to the Reader Group 

main menu. 
 
 If an EW unit, not connected to the network, is programmed, the settings will 

still be saved and programming will take effect whenever the EW is physically 
connected to the RS485 bus. 

 
Modify a Reader Group    
 

 
The default Reader Groups i.e. No Access and Full Access cannot be 
modified. 

 
1. Double click on the Reader Group to be modified; the Reader Group main screen, with 

corresponding selections for the Reader Group is displayed. 
2. Click the Modify button, and make changes in the selection of EW units to form a group 

and description for the Reader Group. 
3. Click the Update button to Save the changes done to the Reader Group. 

 
Delete a Reader Group    
 

1. Double click on the Reader Group to be deleted. 
2. Click on the Delete button and the following message box is displayed. 

 
 
3. Click Yes to delete the Reader Group. 
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If the Reader Group is assigned to a User Group, it cannot be deleted. The 
following message is then displayed. 

 
 

8 TIME ZONES  
 
The Time Zone menu enables time schedules to be defined so that each user can only be granted 
access within particular time periods on each day of the week. 
Click (+) Time Zone and the folder expands, displaying four default Time Zones: “Never”, 
“Always”,  “Priority” and “Free Access (time)”.  
Never (00): Access is denied at all periods and all days. 
Always (01): Full access, 24 hours, 7 days a week, throughout the year. 
Priority (02): Time zone (02) linked to Priority alarm is User definable. 
Free access time (03): Time zone (03) linked to Free access is User definable. 
 

 
Time zones Never (00), and Always (02) cannot be modified or erased. 
Time zones Priority (02), and Free Access time (03) can be modified but 
cannot be erased. 
 

 
Double click on either of the default Time Zones and a similar screen shown below is displayed. 
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Creating a Time Zone 
 

1. Right click the “Time Zone” on the tree structure and then click “new”. 
Or 

2. Click (+) Time Zones and double click on any of the default time zone. 
3. In the Time Zone main screen click the New button. 
4. Enter a description for the Time Zone. 
5. Enter the Start and End times for one or all of the required periods of a day. 

 
Time Zone times are in a 24-hour format. 

 
6. Clicking on the empty square box to the right of each line will duplicate the Start and End 

time information from the previous day. 
7. Click the Save button, the Time Zone created is saved and added to the Time Zone main 

menu. 
 

Modify a Time Zone 
 

 
The default Time Zones i.e. Never and Always cannot be modified. 

 
1. Click (+) Time Zones and double click on the time zone to be modified. 
2. In the following screen click the Modify button. 
3. Change the description and set the time for each period and each day as required. 
4. Click the Update button to save the changes done in the Time Zone. 

 
Delete a Time Zone  
 

1. Click (+) Time Zones and double click on the Time Zone to be deleted. 
2. Click the Delete button and the following is then displayed. 

 

 
 

3. Click Yes to delete the Time Zone. 
4. If the Time Zone is assigned to a User Group, it cannot be deleted and the following 

message box is displayed. 
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8.1 Priority Alarms 
 
Priority time zone enables time schedules to be defined for triggering of Priority alarm for Door 
Open Too Long event. 
If the Door Open Too Long event occurs within Time Zone 02, Output T5 will be triggered. 
If the Door Open Too Long event occurs outside Time Zone 02, Output T4 will be triggered. 
 

 

By connecting suitable warning devices to Outputs T4 and T5, appropriate 
signals can be sent out. For example, a voice-messaging unit can be 
connected to Output T5 and a siren to Output T4, and Time Zone 02 
programmed for office hours. Then, during office hours, a Door Open Too 
Long event will trigger a voice message and outside office hours, the same 
event will trigger an alarm. 

 
To define Time Schedule for triggering of Priority alarm 
 

1. Double click on Priority Time zone and click Modify button. 
Or 

2. Right click on Priority Time zone and click Modify button. 
 

 
 

Note: To clear any previously defined time schedules for the Priority alarm, click Reset button. 
 

3. Change the description and set the times for each period and each day, as required. 
4. Clicking on the empty square box to the right of each day will duplicate the Start and End 

time information from the previous day. 
5. Click the Update button to save the changes. 
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8.2 Free access (Time) 
 
Free access (Time) enables time schedules to be defined for the Free Access door to be open. 
 
To define Time Schedule for Free Access  
 

1. Double click on Free Access (time) Time Zone and click Modify button. 
Or 

2. Right click on Free Access (time) Time Zone and click Modify. 
 

 
 
Note: To clear any previously defined time schedule for Free access, click Reset button. 
 
3. Change the description and set the time for each period and each day as required. 
4. Clicking on the empty square box to the right of each line will duplicate the Start and End 

time information from the previous day. 
5. Click the Update button to save the changes. 

 
9 HOLIDAYS 
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Assigning Holidays is done through the Holidays menu. New year is the default holiday and can 
be modified but cannot be deleted. 



                                                                                                              PRO Software User Manual Ver 1.00E 
   

     www.xprsec.com

 
Holidays entered are automatically carried forward each year and care must 
be taken to ensure that holidays whose dates change from year to year are re-
entered annually. 

 

 
A user can be given access on a Holiday, if linked to a User Group containing 
the Time zone in which time periods on a holiday are defined. 

 
Entering Holidays 

1. To expand the Holiday menu (click on “+”). 
2. Double click on New Year (default Holiday). The Holiday screen is displayed. 

 
3. Click the New button. 
4. Enter the name or description of the Holiday. 
5. Click the  button in the date field and select the date from the drop down calendar. 

 
 

6. Enter any notes for the Holiday in the Comments text box. 
7. Click the Save button and the Holiday name will automatically be added to the Holidays 

menu. 
 
Modify Holidays 
 

1. To expand the Holiday menu (click on “+”). 
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2. Double click on the Holiday icon from which the details are to be modified. 
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3. Click the Modify button. 
4. Make the necessary changes (steps 4 – 6 of Entering Holidays above). 
5. Click the Update button to save the Modifications. 

 
 
 
Delete Holidays 
 

1. To expand the Holiday menu (click on “+”). 
2. Double click on the Holiday icon from which details are to be deleted. 

 
3. Click the Delete button. 
 

 
 

4. Click  Yes to delete the Holiday. 
 

10  USER GROUPS 
Reader Groups and Time Zones can define User Groups. A User Group determines where and 
when a user’s Card or Code will be valid (i.e. to a group of doors within a time schedule). 
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Click (+) User Group and the folder expands to display two default User Groups: “Nowhere” and 
“Everywhere”.  
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1. "00" User Group is pre-defined for ‘Nowhere’ or no access to the entire system. 
2. "01" User Group is pre-defined for ‘Everywhere’ or full access to the entire system. 

 

 User group Everywhere overrides Anti-Pass back and Mantrap settings. 

 
Create User Group 
 
1. Right click the “User Group” on the tree structure and then click “new”. 

Or 
2. Click (+) User Group and double click on either of the default User Groups “Nowhere” or 

“Every where”.  

 
3. Click the New button. 
4. Enter a description for the User Group. 
5. Select an appropriate Reader Group and Time Zone. 
6. Tick the Enable Anti-Pass back checkbox, if required. 
 

 
For the Anti-Pass back feature to function in the system, it has to be set for the 
Controller or Extension units in the Network menu and enabled in the User 
Group menu. 

 
7. Select either Real or Timed Anti-Pass back (with timing from 1 to 30 minutes)  
8. Click Save and the User Group icon is added to the folder. 

 
The User Group number is auto generated on saving a User Group. 

 
Modify User Group 
 

1. To expand the User Group menu (click on “+”). 
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2. Double click on the User Group icon needing modification. 
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3. Click the Modify button 
4. Make the necessary changes (explained in steps 3 – 6 of Creating User Groups). 
5. Click the Update button to save the modifications. 

 
Delete User Groups 
 

1. Expand the User Group menu (click on “+”). 
2. Double click on the User Group icon needed for deletion. 

 
 

3. Click the Delete button. 

 
 

                                33 

4. Click Yes to delete the User Group. 
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If the User Group contains other User details it cannot be deleted and the 
following message is displayed. 

 
 
 
11 USERS 
 
his Users screen allows to add, modify, view or delete user related information. 
Enter User Details 
Double click the Users icon and the following window is displayed:  

 
1. Click on New and then the General tab. 
2. Enter the user’s name in the text boxes provided. 
3. Select the User Group (all created User Groups will be listed in the drop down menu). 
4. Select the User Type (Code or Tag ).  
5. Enter or select the User code / Tag number (generated through the sequential card 

programming screen, refer to page 11). 
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 If cards or key fobs do not have a number marked on them, they can still be 
assigned. Make sure that PRO is online. Place the cursor in the code or tag 
window, and present the card or key fob on either of the readers of the O2LA 
controller. The number will be read and automatically entered. Numbers 
entered this way cannot be edited after entry. 

 
6. Click “Add” to browse and select the picture of the User. Before adding an image into the User 

details screen, the image (i.e. a digital photograph of the user) has to be saved to the system: 
a Scan the photograph of the user. 
b Using an image editing tool, set the picture size to 23mm (width) x 28mm (height). 
c Set the pixels of the image to 69 x 85, and resolution 30. 
d Save the image with a .JPEG extension. 
 

 
If the image selected for a user does not conform to the above specifications, 
there is every possibility that it will not be properly displayed during Online 
Monitoring. 

 
7. Tick the Enable Validity period checkbox and specify the validity period for the User 

code/Tag to be active. 
8. Tick the Enable Priority Code checkbox to assign the User code as a Priority code. 
 

 

A priority code user is a person who can gain access-to-access points 
when the O2LA and / or the RS485 network is disabled. Please refer to 
the O2LA manual for more details. 

9. Tick the Duress code checkbox to assign a User code as a Duress code. 

 

Duress code is for use in emergencies. When, for example, a user has 
been unwillingly forced to open a secure access point, the Duress code 
can be employed. The system can be configured such that the door will 
open with the Duress code and, simultaneously, a silent alarm be sent 
through an automatic dialer or a distant siren. 

10. Click the Contact Details tab and enter the contact details of the user. 
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11. Click the Personal Details tab and enter the personal details of the user. 
 

 
 

12. Click Save, and the user details are saved and displayed in the user details list. 
 
13. Click  View All to view details of all programmed users. 
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User Details List 

 
 

 

O2LA and the PRO have been designed to function independently. Therefore 
it is possible that user information may not be identical for both. To obviate this 
problem, the following color-coding system has been used. 

• A user present in both O2LA and PRO is highlighted in Green. 
• A user entered in PRO, but not exported to O2LA, is highlighted in 

Yellow. 
• A user deleted directly in O2LA but continues to be present in PRO 

after importing is highlighted in Red.  
 

 

If a user is present in both O2LA and PRO, and subsequently deleted in O2LA 
and the information is imported to the PRO, user details in PRO are not 
deleted. However, this user’s information does not get exported back to O2LA, 
and the user is not granted access at any time on any access point. This is 
done advisedly as the PRO can contain a lot of personal information about the 
user that could be lost on deletion. 
To totally delete all information about a particular user, the user has to 
be deleted separately in O2LA and the PRO. 

 
To Copy and Paste the details of a selected user 
  
This option is useful when a user is given two different user codes as it reduces tedious re-entering 
of user details. 
 
1. Select the user from the User details list. 
2. Click the Copy button to copy the selected user details on to the clipboard. 
3. Click the New button. 
4. Click the Paste button to paste the user details that were copied. 

 Details like User Group and User Code are not copied. 

 
5. Enter the User Code and select the User Group. 
6. Click the Save button. 
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1. Double click the Users icon.  
2. Select the user from the User details list. 
3. Click the Modify button and change the user information as required. 
4. Click the Save button. 
 
To Delete User details 
 
1. Double click the Users icon. 
2. Select the user from the User details list. 
3. Click the Delete button. 

 
4. Click Yes to delete the selected User details. 

 
12 EXPORT 
Export refers to the transferring of Settings from PC to the O2LA Controller.  

 
New settings entered in the PRO will be effective only after successful 
completion of export. 

 
1. Double click the Export option. 
2. Click the Export button to transfer the settings from PC to Controller. The familiar Windows 

“copy” screen, with the progress indicator bar (shown below) will appear. 

 
3. After a successful export, click the Exit button to exit. 
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13 IMPORT 
 
The import function refers to the transmitting of Settings and / or Events from the O2LA controller 
to the PC.  

 It is recommended that an Import operation be done daily, during log in, 
to transfer all previous events to the PRO. 

 
1. Double click the Import option to display the following screen. 

 
 

2. Check the required settings or events to be imported.  

 Ensure that the PC is online otherwise error messages will appear. 

 
3. Click the Import button to start receiving data from the Controller. 
4. After a successful import, click Exit. 

 
14 OPERATORS SETTING 
 
The PRO gives a lot of flexibility to its users (i.e. PRO users or Operators, as opposed to system 
users) different degrees of rights for different features. 
Operators are personnel who are given different access rights to screens in the PRO software. 
The Administrator can create up to 10 of these Operators.  
 

 
Operator rights pertaining to the PRO do not, in any way, affect the 
rights for the Administrator and Engineer in the O2LA. 

 
 It is advised that the Administrator creates an Operator name and 

password for himself or herself, giving access to the screens which he / 
she uses for daily operation. Logging in as an Administrator (which is a 
very powerful position) is done only when access to screens of a higher 
security is required. 

 
Double click on the Operator and the Operator Settings screen is displayed as below: 
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1. Click the New button to expand the screen. 

 
2. Enter the Operator Name (not more than 20 characters). 
3. Provide a Password (minimum 5 and maximum 15 characters). 
4. Re-enter the password to confirm.  

 The password entered is case sensitive 
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5. Select the language. This option ensures that when an Operator logs in, all the menus are 
in the language selected for that particular operator.  
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 This is a powerful feature because, on the same PRO installation, 
Operator A  logging in will have menus in one language and Operator B 
logging in will have menus in a different language. 

6. Set the Access Rights for each screen. Three options are possible. 
a. No Access: No access for the Operator for the corresponding screen. 
b. View Only:  The Operator can only View the corresponding screen and no modifications 

can be done. 
c. View/Modify: The Operator can View and Modify the corresponding screen. 

 If No Access for a screen is specified for a particular Operator, that 
screen will not even be displayed when the Operator logs in. 

7. Click Save to store the New Operator Settings.  

 

When any new User Group or Reader Group, etc. is created, their names 
and icons will automatically appear on the Tree Menu. However, as a 
security precaution, when a new Operator is added, the name is NOT 
displayed on the Tree Menu. 

 
Modify Operator 
 
1. Double click the Operators option. 
2. In the screen displayed, select the Operator name from the drop down. 
3. Click the Modify button and modify the settings as required. 
4. Click the Change password button to change the Operator’s password. 
5. Click the Update button to update modifications. 

 Only the Administrator can change passwords. 

 
Delete Operator 
 
1. Double click the Operators option. 
2. In the screen displayed, select the Operator name from the Name drop down. 
3. Click the Delete button. 

 
4. Clicking Yes deletes the selected Operator. 
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15 REPORTS  
 
Double click Reports in the Tree structure to see a set of standard reports, and a Wizard to 
create customized reports. The following choices will be visible in the Tree menu: 
 
• Report Wizard  
• Events Report 
• Graphical Report 
• Saved Reports 
• Tag Details Report 
• Attendance Report 
 
15.1 Report Wizard 
 
The Report Wizard is a user-friendly procedure for creating customized reports of events relating 
to a User. The Report Wizard consists of 6 steps with a Finish button in each step.  
 
Double click on the Report Wizard option to display the following screen. 
 

 
 

1. Select the Date and Time period for the required events report. 
2. To create a Report that includes all the events that occurred within the selected Time 

period, click the Finish button. 
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3. Enter the Report name to be displayed in the report and click the OK button to view it. 

Or 
Click the Next button and the following screen is displayed. 

 
 

4. Select the User Groups and click the Add button. 
5. To create a Report with all the events for the selected User Groups and Time period, 

click the Finish button.  

 
 
6. Enter the Report name to be displayed in the report and click the OK button to view it. 

Or 
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Click the Next button and the following screen is displayed. 
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7. Select the required users and click the Add button. 
8. To create a Report with all the events for the selected Users and Time period, click the 

Finish button.  

 
 

9. Enter the Report name to be displayed in the report and click the OK button to view it. 
Or 

 Click the Next button and the following screen is displayed. 
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10. Select the Doors options and click the Add button. 
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11. To create a Report with all the events for the selected Doors, Users and Time period, 
click the Finish button. 

 
 

12. Enter the Report name to be displayed in the report and click the OK button to view it. 
Or 
Click the Next button and the following screen is displayed. 

 
 

13. Select the Events for which the Report is required and click the Finish button. 

 
 

14. Enter the Report name to be displayed in the report and click the OK button to view it. 
Or 
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   Click the Next button and the following screen is displayed. 
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15. Select the Sort Order to which the events displayed in the Report are to be sorted. 
16. Enter the Report name. 
17. If the Report is to be saved, tick the Check the box for saving the report to store it. 
18. Click the Finish button to view the Final report. 
 

 Click the Cancel button at any time, to quit the Report Wizard. 
Click the Back button at any time, to get back to previous step. 

 
15.2 Events Report 
 
This is a standard report, which can be generated quickly, without going through the procedure in 
the Wizard. This option generates an Events report of selected types of events that occurred on 
a particular date or between two dates. 
Double click on the Events Report option displaying the following screen listing all possible types 
of events. 
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1. Select the On date   radio button. 
2. Select the date of the Events report. 

Or 
Select the Date between  radio button. 

3. Select the ‘From’ and ‘To’ dates of the Events report . 
4. Select the type of Events from the Events list. 
5. Click the Add button. 

Or   
Click the Add all button to add all the Events contained from the Events list to the 
Selected Events list. 

6. Click the Remove button to remove a selected Event from the Selected Events list. 
7. Click the Remove all button to remove all the events from the Selected Events list. 
8. Click the OK button and an Events Report for the selections made is displayed. A sample 

events report is shown below. 

 
 

9. Click the Export to Excel button and an Events Report for the selections made is displayed 
on an Microsoft EXCEL worksheet. 

 

The password to edit the Excel sheet is “admin”. 
The password can also be changed using the password change option given 
in MS Excel. 

 

 

In order that the Report can be displayed on a Microsoft EXCEL worksheet, 
MS EXCEL must be installed in the system. 
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10. Click the Exit button to quit the Events Report option. 
 

15.3 Graphical Report 
 
This option is used to generate a graphical report for the total number of  Users in selected User 
Groups. 
Double click on the Graphical Report option to display the following. 
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1. Select the User Groups for which the Graphical report is required. 
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2. Based on the selected User Groups, the User Group range selection radio buttons will be 
enabled. 

• Up to 25 User Groups 

• 26 to 50 User Groups 

• 51 to 75 User Groups 

• 76 to 100 User Groups 
3. Select the User Group range for which the Graphical report is required. 
4. Based on the User Group range selected, the User Group Number and the Total Users in 

selected User Groups are automatically displayed. 
5. Select the Chart type to generate the Graphical report. 

• 2D Combination chart 

• 2D Bar chart 

• 2D Line chart 

• 2D Area chart 

• 2D Step chart 

• 2D Pie chart 
6. Click the Print button to print the generated Graphical report. 
7. Click the Exit button to quit the Graphical report option. 

 
A sample generated Graphical report using a 2D Pie chart is shown below. 
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15.4 Saved Reports 
 
This option lists all the Reports Generated that are Saved in the Report Wizard option. The 
report selected can be Edited, Deleted or Viewed. 
 

 
 

1. Select the Report from the drop down. 
2. Click the Open button to view the selected Report. 
3. Click the Edit button to change the parameters selected for report generation. 
4. Click the Delete button to delete the selected Report. 
5. Click the Exit button to quit the Saved Reports option. 
 

15.5 Tag Details Report 
 
With this option Tag Details reports can be generated for different categories of users. 
Double click on the Tag Details Report option, and the following screen is displayed. 

 
 

1. Select the category for which the Tag Details Report is required. 
2. Click the OK button and the corresponding Tag Details report is displayed. A sample of such 

a report  is shown below. 
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15.6 Attendance Report 
 
This option is used to generate an Attendance access report for selected doors from selected 
controllers and for a selected Time period. The Attendance Report generated can be exported to 
a Microsoft EXCEL worksheet and printed. 

 This feature enables the attendance record to be processed further, e.g. for 
calculating payroll. 

 

 

An Attendance report registers the time when a user enters and leaves a 
secure area. Therefore the doors need to be set in Anti Pass back 
enabled and Pulse modes. 

 

 
Users assigned with a  “Priority Code” or users belonging to a User Group 
“Every where” will not be listed in the Attendance Report. 

  
 
Double click on the Attendance Report option and the following screen is displayed. 
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1. Select the Controller or Extension Unit(s) for which the Attendance Report is to be generated. 
2. Select the Time period for the Attendance Report. 
3. Click the Export to Excel button to export the Attendance report to an EXCEL worksheet for 

printing. 

 

The password to edit the Excel sheet is “admin”. 
The password can also be changed using the password change option 
given in MS Excel. 

 

 
In order that the Report can be displayed on a Microsoft EXCEL 
worksheet, MS EXCEL must be installed in the system. 

Or 
4. Click the OK button to view the Attendance Report and take a print out. A sample of the 

attendance report is shown below. 
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16 BACKUP 
A Backup menu is provided with the three options listed below: 
• Manual Backup 
• Restore Database 
• Clear Events Database 
 
16.1 Manual Backup 
 
This option allows a manual backup (make a copy) of the PRO database. 
 
1. Click the Backup menu and select the Manual Backup option. 

 

 
 

2. Click Select Backup Location button. 
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3. Browse and select the path for Backup of the PRO database. 
4. Click the Backup now button to create a backup in the selected path. 
5. Click the Exit button to quit the Manual Backup option. 
 
16.2 Restore Database 
 
This option restores a selected Database into the PRO. 
1. Click the Backup menu and select the Restore Database option. 

 
2. Click the Select button and choose a database to be restored. 
3. Click the Restore button to restore the chosen Database. 
4. Click the Exit button to quit the Restore Database option.  
 
16.3 Clear Event Database 
 
The Clear Events Database option clears all events from the database. 
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1. Click the Backup menu and select the Clear Event Database option. A warning message 
below is then displayed. 
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2. Click Yes to take a Backup of the current database before clearing the events. 

 
3. To take a Backup follow Steps 2 – 4 of the Manual Backup option (Refer to page 53). 
4. Clicking No clears all the events in the Current database. 

 
 
 
 
17 DIAGNOSTICS 
 
This menu displays the status of all 32 units on the RS485 network. This option functions only if 
the O2LA is connected to a computer running PRO software. 
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1. Click the Diagnostics menu and select the Diagnostics option. 
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2. Status of all the 32 units on the RS485 network can be viewed. 
3. A Green symbol against the unit indicates an active unit. 
4. A Red symbol against the unit indicates an inactive unit. 

 A unit may be inactive for several reasons including power off, RS485 line 
disruption or an EW may not be properly configured, etc. 

5. Click the Exit button to quit the Diagnostics option. 
 
18 DISABLE ALARM           
 
This option is to disable (switch off) the Output 4 (T4) trigger. Disable alarm functions only when 
the computer is connected to O2LA. 

 Output 4 (T4) can also be disabled directly with O2LA by entering the 
Master code. 

 
19 SETTING RECORDS 
This menu gives a list of options in PRO for generating reports of settings that can be viewed or 
printed. 

 If it ever becomes necessary to reinstall the PRO software, a hard copy of 
all settings will be very useful to bring back O2LA to normal operation. 

The options in the Setting Records menu are listed below: 

• Reader Groups 
• Time Zones 
• Holidays 
• User Groups 
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• User Details 
• Anti-Pass back  -> User Groups 

      Door Controllers 
 
 
19.1 Reader Groups Settings Report 
 
This option gives a report displaying all the Reader Groups with details created in the Reader 
Group option. A sample of the report is displayed below: 
 

 
 

1. Click the buttons    to navigate between the pages and select the page to be printed. 

2. Click the Print ( ) button to make a print. 
3. Click  the   button to quit the Report. 
 
19.2 Time Zones Settings Report 
 
This option lists a report displaying all the Time Zones created, with details like Time Zone 
number, Description, Day and Period with Start and End time. A sample of this report is displayed 
below. 
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1. Click on the buttons   to navigate between the pages and select the page to be printed. 

2. Click the Print ( ) button to make a print. 
3. Click the  button to quit the Report. 
  
19.3 Holidays Report 
 
This option lists out a report displaying all the Holidays entered in the Holidays option. 
A sample of the report is displayed below: 
 
 

 
 

1. Click the buttons   to navigate between the pages and select the page to be printed. 

2. Click the Print ( ) button to make a print. 
3. Click  the  button to quit the Report. 
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19.4 User Groups Settings Report 
 
This option lists a report displaying all the User groups with the details that were created in the 
User Group option. A sample of the report is displayed below: 
 

 
 

1. Click on the buttons    to navigate between the pages and select the page to be printed. 

2. Click  the Print ( ) button to make a print. 
3. Click the  button to quit the Report. 
 
19.5 User Details Report 
 
This option lists a report displaying all the Users with details, created in the Users option. 
A sample of the report is displayed below: 
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1. Click the buttons   to navigate between the pages and select the page to be printed. 
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2. Click the Print ( ) button to make a print. 
3. Click  the  button to quit the Report. 
 
19.6 User Group with (APB) Settings Report 
This option lists a report displaying all the User groups with the Anti-Pass back feature 
enabled. A sample of the report is displayed below: 
 

 
 

1. Click the buttons   to navigate between the pages and select the page to be printed. 

2. Click the Print ( ) button to make a print. 
3. Click  the  button to quit the Report. 
 
19.7 Door Controllers with (APB) Settings Report 
 
This option lists a Report displaying the Door Controllers that are Anti-pass back enabled. 
A sample of the report is displayed below: 
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1. Click the buttons   to navigate between the pages and select the page to be printed. 

2. Click the Print ( ) button to make a print . 
3. Click the  button to quit the Report. 
 
20 HELP  
 
The Help menu is built around the options listed below: 

• Online Help 
• About 
• Registration 
 

20.1 

20.2 About 

Online Help 
 
Click the Online Help option or press the F1 shortcut key to view the help file. 
 

Click the About option or press the F2 shortcut key to view the software version information. 
 

 
 
20.3 Registration 
A PRO software CD is sent free with every O2LA shipped out of the factory. O2LA and the PRO, in 
this situation, function entirely independently. Both can be programmed separately. However, there 
is no data transfer between O2LA and the PRO. 
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All supplies from the factory contain both the O2LA and the PRO CD. 
O2LA can be bought either with or without a Registration Code.  

Register the PRO software by filling the registration details in the Registration Form. 
1. Click the Help menu and select  the Registration option, as displayed below. 

 
2. Enter the name of the Company. 
3. Click the Retrieve button to obtain the O2LA Serial Number of the O2LA. 

Or 
Enter the O2LA Serial number written on the O2LA controller. 

4. Enter the unique Registration code (Security code) which either accompanies the product at 
time of purchase or can be bought later directly from your distributor. (Refer also to page 64) 

5. Click the Save button to store the Registration details. 
6. Click the Exit button to quit the Registration Form. 
 
21 Changing Languages:  
 
The PRO software currently supports the following languages. 

• English 
• French 
 

1. The default language is English. 
2. The login session is in the language specified in the Global Setting Parameters -> Sync / 

Language settings. 
3. The PRO Software language for each Operator can be set in the Operators settings menu. 

(Refer to page 39) 

 

Certain messages displayed in the PRO software depend on the 
language of the PC Operating System. For example, if French is 
selected as the language for PRO Software and the Operating System 
of the PC is set to English, the PRO software menus will be 
predominantly in French with some displayed in English. 
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22 TROUBLE SHOOTING 
Message box Problem Solution 

 

 

A Com Port may not 
be available or may 
be used by some 
other software. 

If a Com Port is not 
available and the 
USB Port is 
present, use a USB 
– RS 232 Converter 
(Cable) for 
Communication. 
If  a Com Port is 
used by some other 
software, close the 
Software using the 
Com Port and then 
start  PRO 
software. 
 

 

 
 

 
This message box 
appears if the Holiday 
data exported to 
O2LA is 365 days 
ago. 

 
Click Yes and 
export the Holiday 
data to the O2LA 
Controller. 

 

 
 

 
The Registration code 
in the Registration 
form  is not entered 
or entered 
incorrectly. 
 

 
Enter the Unique 
Registration code 
given for O2LA 

  
This message arises if 
an attempt is made to 
uninstall PRO when  
logged in as other 
than the 
Administrator. 

 
Log in as 
Administrator and 
then uninstall the 
software. 
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23 GLOSSARY 
Anti-Pass back (APB) 
 
A feature that prevents the misuse of a card by a user giving his or her code/tag to someone else  
to gain access. There are two types of APB. 
 
Real Anti -Pass back 
 
A valid and authorized user is granted access at the ‘IN’ reader and cannot re-use the code/tag to 
regain entry into the zone until the same card has been used to leave the area. 
 
Timed Anti -Pass back 
 
A valid and authorized user is granted access at the ‘IN’ reader and subsequently cannot re-use 
the code/tag to regain entry into the zone until a pre-set time-period has elapsed. 
 
Mantrap 
 
This function is used to prevent one door opening while another door is still open. It is a special 
configuration where one door must be closed before another door can open as in an “airlock” 
situation. 
 
Priority codes 
 
Priority codes are the codes with super access rights. The PRO software allows programming of 
up to 10 Priority codes at memory locations between 990 to 999 for use in case of emergencies. 
These Priority codes are given “FULL” access as they are granted “Always Access” at any 
reader connected to any EW on the network.  
 
Priority codes are for use in emergency situations such as: 

• RS 485 cable cut on the network. 
• Communication problem with O2LA. 
• System failure or power supply interruption to the O2LA. 

These Priority codes are designed for Security Maintenance personnel or the Administrator. 

 
Anti-Pass back or Mantrap settings for the O2LA or the EW extension units 
are disabled for these codes. 

 
Registration code 
 
The product is shipped from the factory in one of two ways, depending upon the order request. 
1. The O2LA controller together with the PRO software CD, including the Registration code. 
2. The O2LA controller together with the PRO software CD, without the Registration code. 

 
The PRO can communicate with the O2LA only if a valid Registration code is entered in the PRO.  
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Free Access 
 
A special programming feature to enable 1door in the system to remain open for time set in Time 
zone 03, without need for card/tag validation. Useful, for example, to keep a parking lot gate 
open during the start and close of office hours. 
 
Readers 
 
Readers are slave units that operate with the controller. They can be either a keypad or a proximity 
reader with a 26-bit Wiegand communication protocol. XPR’s proximity readers read only EM4002 
formatted cards. If other readers are used then specifications need to be checked for compatibility. 
 
Reader Group  
 
A Reader Group is a group to which specific units (00 to 31) are assigned with ‘rights’ for the 
readers connected to those units. 
 
RS232 
 
A popular computer interface for serial data transmission over distances of less than 15 meters (or 
50 feet). Employs a standard 9-pin D-type connector. The O2LA system uses the RS232 interface 
to connect to a computer, printer or modem.  
 
RS485 
 
RS485 is a widely used international standard for multi-point data communications. It enables up 
to 32 nodes to be connected through a simple twisted-pair cable with a length of up to 1 Km (or 
4000 feet).  
 
Tag 
 
A Tag can be card or a key fob with an embedded IC encoded with a number that can then be 
sensed by a reader. XPR’s MULTIX range of readers can read tags compatible with EM4002 
format. 
 
24 FEEDBACK 
If you have any constructive comments about these products please forward them to the following 
address:  
 
India Office 
 
M/s. SY TECH ENGINEERING PVT LTD 
#408,4th Floor, Citicentre,   
EDC Complex. Patto Plaza, 
Panaji,Tiswadi , 
Goa  
Phone : (91) 0832 - 2437128, (91) 0832 – 2438632. 
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Europe Office  
 
Rue de l'Etoile 39, 1180, Brussels, Belgium 
Tel: (32) 2 – 5520890 / Fax: (32) 2 – 5520899 / E-mail : xpreur@xprsec.com.   
  
25 Disclaimer 
 
The Software is to be installed in accordance with XPR’s instructions. The Software is provided “as 
you find it” and XPR does not accept any collateral damage and contingent liabilities arising from 
misuse or failure of the product. 
 
26 COPYRIGHT 
Copyright © 2004 XPR Ltd. All rights reserved. O2LA-PRO for Microsoft® WindowsTM. 
 
The Software should not be reproduced or distributed in any form or by any means in whole or in 
part without prior written consent of XPR. 
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